
        Exit

Use this command to leave Pro One Term paper and return to Windows.    Exit
can be found directly on the toolbar, or by clicking on File to use the File 
Menu.

If the current term paper or outline needs to be saved, a pop-up will provide 
a warning and a chance to do so before you exit from the program.



Save As

Use this feature of the File Menu to save the current term paper and/or 
outline under a different name.    A pop-up will then prompt you to type in the
new name.

          

User's Tip:    Unless you specify otherwise, the standard file extension will 
be .TPP.    For ease of use, the term paper and its outline are saved together 
in a single file.



Save

Use this feature of the File Menu to save the current term paper and/or 
outline.

If you've saved this term paper before, it will be updated under the existing 
name.    If you haven't saved this term paper, you'll be prompted to assign it 
a name before it is saved.



Open

Use this feature of the File Menu to open an existing term paper and/or 
outline.    When you do, a pop-up will prompt you to select a term paper.    
Simply click on the one that you want to use, then on OK, and you'll be ready
to go to work.

          

User's Tip:    Unless you're specified otherwise, all of your term papers are 
stored with a .TPP extension.



New

Use this feature of the File Menu when you're ready to create a new term 
paper and/or outline.

If the previous term paper was edited but not saved, you will be warned and 
you will have the option to save your changes before you lose any important 
information.



Help About
Click here to see the Help Menu's About Box and learn more about Pro One 
Term Paper.



Help on Help

Click on this Help Menu option to get information about how to use the Help 
system.



        Search
Clicking on the binoculars will start a search for a specific piece of text.    
Clicking on the binoculars with the blue '+' will search again for the same 
text you searched for before.



        File Menu
The File Menu provides all of the features necessary to create, update, and 
save outlines and term papers.    In addition, you can use it to exit from Pro 
One Term Paper and return to your other activities.

Click on File and you'll see a pull-down featuring the following commands:

To learn more about any of these File features, simply click on it, now.



        Idea Bank
Use this toolbar command to access a variety of idea-generating tools 
designed to help make writing your term paper even easier.

After you click on Ideas, you'll be prompted to choose among the following 
useful options:

For more information, click on any of these features to see its Help, now.



        Help Menu
Use this toolbar option to learn more about how to use Pro One Term Paper.    
A pull-down will prompt you with standard Windows Help features that 
provide full information on how to get the most out of this program.

To learn more now, click to see the Help listings for the options that appear 
on the Help menu:

User's Tip:    Pro One Term paper's Help feature follows standard Windows 
conventions.    So if you're experienced at using the Help in other software 
packages, you probably won't have any problems using this one, either.



        Copy

Use this to copy the selected text.    Then use Paste to place it in the new 
location in your term paper.

To select text, proceed in the usual Windows fashion:    position your pointer 
at one end of the section, press down the left mouse button and drag the 
highlight until the entire section is selected.

User's Tip:    To move information, use the Cut tool instead of Copy and save 
yourself a step.    Or for more information about selecting text in Windows, 
consult your Windows User's Guide.



        Insert Page Break

Click on the Body Box's Page icon to insert or remove a page break at the 
end of the current section.    Forced page breaks can only occur at the end of 
a section.    If the page icon has a gray page with an 'x', then there will be no 
page break after this section.    If the page icon has a white page with a 
checkmark, then there will be a page break after this section.

User's Tip:    If you find that a page is printing 'funny', make sure that you 
haven't accidentally left an old page break in a place where you no longer 
need it.



        Paste

After you've used Cut or Copy to store a selected section of text in the 
Windows clipboard, use Paste to insert it back into your term paper or 
outline.

User's Tip:    Since Paste works off of the Windows clipboard, you can use this 
command to add text from other Windows applications:    simply copy the 
text to the clipboard in another application, switch to Pro One Term Paper, 
place the cursor at the desired insertion point and paste the text into your 
document.



        Cut                                                                                     

Use Cut (the scissors icon) to delete selected text from your term paper or 
outline.    Then you can leave it deleted, or use the Paste tool to place the 
text in a new location.

To select text, proceed in the usual Windows fashion:    position your pointer 
at one end of the section, press down the left mouse button and drag the 
highlight until the entire section is selected.



        Undo

Click on the Body Box's Undo icon to reverse your most recent editing 
operation.    If there is no operation to be 'undone', a pop-up will warn you; 
otherwise, the change will be made.



        Fonts

Use this Body Box option to specify font characteristics for all or part of your 
term paper.

When the pop-up appears, click to make your selections for the font, font 
size, font face (bold, italic or underline) and color.    Then click on OK to save 
your changes, or on Cancel to ignore them, when you're done.

          

User's Tips: You can also use the Body Box's Character Formats and the 
Character Colors buttons to adjust your text's appearance.



        Text Alignment

Click on the Body Box's justification options to specify your text's alignment.  
The justification that you click to choose will be applied to the selected 
(highlighted) portion of your term paper.    To make another choice, simply 
click again.

The justification options include:

Left justify: To place the text flush with the left-hand margin
Center justify: To place each line of text so it is centered on the page
Right justify: To place the text flush with the right-hand margin
Double justify: To place both ends of the text flush with their margins

Feel free to experiment with the choice that suits your needs.

User's Tips:    Left or double justify are the options most commonly used for 
the body of a term paper; center justify is useful for title pages and figures.



        Character Formats
Click on the Body Box's character format options to specify how your text will
appear when it's printed.    The characteristic(s) that you click to choose will 
be applied to the selected (highlighted) portion of your term paper.    To 
change your selections, simply click on the tools again.

The character formats include:

Bold: To print text in bold face
Italic: To italicize text
Underline: To underline text

Any combination of these three formats can be applied to any selected 
portion of your term paper.    The on-screen appearance of the text will reflect
your choices, so that you can get an advance idea of how your paper will 
look after it is printed.



Font Colors

                  

When the character colors pop-up appears, click on the color that you'd like 
to use for the selected text.    Then click on OK to save that choice, or on 
Cancel to ignore it.    Your specified change will be made as soon as you 
return to the document.



        Line Spacing

Click on the Body Box icon that represents your preferred line spacing:

- Single spacing
- 1 1/2 spacing
- Double spacing

The portion of text that you've selected will be set to your chosen spacing 
just as soon as you return to the document.    If further adjustments are 
needed, simply click to specify the spacing again.

User's Tips:    Double-spacing is probably the most common choice for the 
text of term papers, although long quotes or excerpts may be single-spaced.  
Line spacing does not apply to your paper's References (or Bibliography) 
section, which follows prescribed formatting rules.    (Click on the highlight for
more information.)



        Insert Graphics
Use this tool of the term paper Body Box to insert a graphics file directly into 
the text of your term paper. The process is easy:

-    Simply click on the icon, and a pop-up will prompt you to select a 
graphics file to insert.

-    Choose the file to insert, and click on OK.

         

As soon as you return to the term paper, you'll see that the insertion has 
been made.

Whenever the cursor is positioned at a graphic image, a group of black dots 
(known as "handles") appear superimposed on that image.    By clicking and 
dragging on these handles, you can resize the image, or move its relative 
vertical position on the current line.

The following types of graphics files can be inserted into the text:    Windows 
Bitmap (.BMP), PC Paintbrush (.PCX), Graphics Interchange (GIF), Tag File 
Format (.TIF), TARGA (.TGA) and Windows Metafile (.WMF).



Using Text Boxes

Text boxes enable you to type in the contents of your term paper or outline.   
You'll see that they are operated in standard Windows fashion:

- Use your mouse to locate the cursor and select text
- Use your keyboard to type in the document
- Use the toolbar commands that appear just above the text boxes to 

format and edit your document.

For more information on creating a term paper or outline, click on the 
highlights to review the Help listings for About Outlines and About 
Formatting; or to learn more about how to use text boxes to create a term 
paper or outline, review the listings for Body Box and Outline Box.    If you're 
still having trouble using the text boxes, consult your Windows 
documentation.



        Move Down Outline Section

Click on the "down arrow" button to move the highlighted outline section 
downwards.    As soon as you do, the selected text will be moved, and the 
outline's numbering will be adjusted to reflect the change.    To move the 
section again, simply repeat the operation.

User's Tip:    For more general information on creating an outline and using it 
to build your term paper, click to see the Help listing for About Outlines.



        Move Up Outline Section

Click on the "up arrow" button to move the highlighted outline section 
upwards.    As soon as you do, the selected text will be moved, and the 
outline's numbering will be adjusted to reflect the change.    To move the 
section again, simply repeat the operation.

User's Tip:    For more general information on creating an outline and using it 
to build your term paper, click to see the Help listing for About Outlines.



        Change Outline Name

Click on this button to make changes to the name of an outline section.    As 
soon as you do, the editing pop-up will appear and prompt you to make your 
changes. The outline will automatically be updated as soon as you're done.

User's Tip:    For more general information on creating an outline and using it 
to build your term paper, click to see the Help listing for About Outlines.



        Delete Outline Section

Click on the "-" button to delete the highlighted outline section.    As soon as 
you do, the selected text will be deleted, and the outline's numbering will be 
adjusted to reflect the change.

User's Tip:    For more general information on creating an outline and using it 
to build your term paper, click to see the Help listing for About Outlines.    To 
move a section of the outline, use the Move Up and Move Down (up and 
down arrow) commands or the Cut option, instead of deleting and retyping.



        Add Outline Section
Click on the "+" button to add a new section to this outline.    The next 
section will be inserted after the section that is currently highlighted.

As soon as you click to select this command, a pop-up will prompt you to 
type in the text for the section that you're adding.    You don't need to add 
numbering:    Pro One Term Paper does this automatically.    Once your text is 
typed in, simply click on OK (to add the section) or Cancel (to ignore it) and 
you'll return to the outline.

User's Tips:    To turn a new section into a sub-section, use the Indent (right 
arrow) button.    And there's no need to worry about chancing the section's 
numbering:    it will be automatically adjusted.    For more information, click to
see the Help listing for About Outlines.



        Indent Outline Section

Click on the "right arrow" button to indent the highlighted outline section.    
As soon as you do, the selected text will be shifted right, and the outline's 
numbering will be adjusted to reflect the change.    To indent the section 
further, simply repeat the operation, or to unindent the section, simply click 
on the "left arrow" button.

User's Tip:    For more general information on creating an outline and using it 
to build your term paper, click to see the Help listing for About Outlines.



        Unindent Outline Section

Click on the "left arrow" button to unindent the highlighted outline section.    
As soon as you do, the selected text will be shifted left, and the outline's 
numbering will be adjusted to reflect the change.    To unindent the section 
further, simply repeat the operation.

User's Tip:    For more general information on creating an outline and using it 
to build your term paper, click to see the Help listing for About Outlines.



        Print Menu

Use this to access Pro One Term Paper's printing-related tools.    Simply click on this 
toolbar command to:

To learn more about any of these features, simply click on it, now.



Page Numbers

Use this option of the Print Menu to add page numbers to your term paper.    
Then, when the pop-up appears, use it to choose among the formatting and 
style selections for your page numbers.



Print Outline

Use this option of the Print Menu to print a copy of the current outline.    The 
print request will be sent directly to the printer as soon as you click to select 
this option.

User's Tips:    To double-check your printer specifications before you print 
your first outline, use the Print Menu's Print Setup command (click on the 
command to see its Help, now).



Set Margins

Use this option of the Print Menu to make changes to your term paper's 
printing margins.    When the pop-up appears, simply click on the up and 
down arrows until you reach the desired dimensions.    Then click on OK to 
save the new settings and apply them to this paper or outline, or choose 
Cancel to ignore them.



Print Term Paper

Use this Print Menu option when you're ready to print a copy of the current 
term paper.    When you do, a pop-up will appear to guide you through your 
various printing options.    Once all of your choices are made, simply click on 
OK to start printing.

User's Tip:    If you're having problems printing from Pro One Term paper, 
begin by checking to make sure that you can print at all, by trying to print 
from another Windows application.    If this doesn't work, consult your 
Windows documentation for assistance.



Print Setup

Use this option of the Print Menu to make changes to your printer selection, 
printing orientation, paper characteristics, or other printing options.    Then 
click on OK to save your updates.



        Spell Check
Use this toolbar command to check your term paper for spelling and typing 
mistakes    Simply click to see the tool's options.    Then, when the pull-down 
appears, click again to specify where you'd like the spell check to be run:

The check will begin immediately.    If any suspicious words are found, the 
follow-up pop-up will appear, and prompt you to make the necessary 
changes.

Make the appropriate selection, and the check will continue.    The checker 
will notify you when it's found another suspicious word or has completed its 
run.

Click on the pop-up, now, to learn more about any of the Spell Check 
features.

User's Tip:    Don't hesitate to add words to your Custom Dictionary, 
especially proper nouns and technical terms that appear frequently in your 
work.



Clear Custom Dictionary

Use this Spell Check command to delete all of the words from your Custom 
Dictionary.    All words in the dictionary will be deleted, and you'll be free to 
start creating a Custom Dictionary again.

User's Tip: Creating a good Custom Dictionary can make spell checking more 
effective and less tedious.    So don't hesitate to add words to your dictionary,
especially proper nouns (such as your name, home town, college, etc.).



Add to Custom Dictionary

Use this Spell Check command to add the highlighted word to your Custom 
Dictionary.    The suggested correction will be ignored, and the spell checker 
will continue reviewing the remainder of your term paper.

User's Tip: Creating a good Custom Dictionary can make spell checking more 
effective and less tedious.    So don't hesitate to add words to your dictionary,
especially proper nouns and technical terms.



Suggested Words

All of the suggested spelling corrections will appear in this box.    The current 
suggested spelling is highlighted:    to change the selection, simply click on 
any word in the box and it will appear in the Replace Box.



Replace Box

The Replace Box contains the current suggested correction.    To change it, 
either:

-    Click on any other word in the Suggestions Box; or
-    Click in the Replace Box to type in a correction of your own.



Replace With
Click on this Spell Check button to replace the checked word with the one that's 
suggested in the Replace Box.    As soon as you do, the replacement will be made and 
the spell checker will continue reviewing the remainder of your term paper.



OK or Cancel
As always in Windows, click on OK to save the current changes or Cancel to 
ignore them.



Ignore Suggested Change

Choose this if you want to ignore any suggested replacements for the 
highlighted word.

User's Tip:    Don't hesitate to add words to your Custom Dictionary, 
especially proper nouns and technical terms that may appear often in your 
term paper.    Doing so can make spell checking more effective and less 
tedious.



Add to Outline

Click on this button when you're finished typing in a new section and are ready to add it 
to your outline.



        Thesaurus
Use this toolbar command to add instant breadth to your vocabulary by 
accessing Pro One Term Paper's handy built-in thesaurus.    Begin by 
highlighting the word you'd like to replace.    Then click on the Thesaurus 
icon.    The following pop-up will appear, providing suggested alternatives (if 
any) and the opportunity to select one.

Click on the pop-up, now, to learn more about any of the Thesaurus' features 
and how to use them.    Or simply give it a try, and you may be surprised at 
how easy it is to make your term paper even more impressive.



Thesaurus Suggestions

All of the suggested alternative words will appear in this box.

The first suggested replacement is highlighted:    to change the selection, 
simply click on any word in the box and it will appear in the Replace Box.    
Then, when you've settled on a favored replacement, simply click on the 
Replace With button and the substitution will be made.



Check Outline

Use this option to spell check the outline, only.    If any suspected 
misspellings are found, a pop-up will prompt you to correct them.    A second 
pop-up will let you know when the spell check is done.



Check All Sections

Use this option to spell check the entire term paper.    If any suspected 
misspellings are found, a pop-up will prompt you to correct them.    A second 
pop-up will let you know when the spell check is done.



Check Current Section

Use this option to spell check this current section of the term paper, only.    If 
any suspected misspellings are found, a pop-up will prompt you to correct 
them.    A second pop-up will let you know when the spell check is done.



        References / Bibliography

Use this toolbar command to record and format your references for this term paper.    Its 
simple-to-use pop-up prompts you to enter the important information, then provides 
options for easy, automatic formatting of your documentation.

Here's what you'll see when you click to select this command.

Click on any of the buttons or boxes, now, to learn more about using it.    Then, when 
you've gotten your references entered, use the Print References command of the Print 
Menu to print a review copy of your documentation.

User's Tips:    For a review of basic information about footnoting and documentation, 
click on the toolbar's Ideas command and select theFootnote Facts option.    (Click on 
any of the highlighted terms, now, for more information.)



    Pro One Term Paper Help
Click on any graphic for more information about that feature.

Main Toolbar

            

Outline Toolbar
            

Text Toolbar

            

Ruler

            

For general information, click on one of the following:
About Outlines
About Formatting



Ruler

The ruler defines the left and right print margins, paragraph indenting, and 
tab stops.    Click below for more information on these features.



Ruler Left Margin
The bottom half of the left arrow in the ruler specifies the left margin for 
printing.    You can change this position by clicking and dragging on this piece
of the arrow.

Click on Ruler for more information.



Ruler Paragraph Indent
The top half of the left arrow in the ruler specifies the paragraph indentation. 
You can change this position by clicking and dragging on this piece of the 
arrow. If the top half of the left arrow is to the right of the bottom half, then 
the first line of the paragraph will be indented to that position.    If the top 
half of the left arrow is to the left of the bottom half, then the entire 
paragraph (except for the first line) will be indented.    This is known as a 
hanging indent.

Click on Ruler for more information.



Ruler Tab Stops
The little upside-down "T"s in the ruler specify the default tab stops.    You 
can create your own tab stops by clicking on the ruler at the location where 
you want a new tab stop.    Tab stops that you define are displayed as large 
arrows.    You can delete one of your own tab stops by clicking and dragging 
down on the arrow.    You can also move one of your tab stops by clicking and 
dragging it to another spot on the ruler.

Click on Ruler for more information.



Ruler Right Margin
The arrow at the right side of the ruler specifies the right margin for printing. 
You can change this position by clicking and dragging on this arrow.

Click on Ruler for more information.



Thesaurus Replace Now
Click here to make the replacement.    The word or phrase that you've 
searched on will be deleted from the text and the one that appears in the 
Replace Box (just below this button) will be inserted in its place.



Thesaurus Replace Box
This box contains the current choice among the alternative words identified 
by the Thesaurus.



Body Box
The Body Box contains all of the tools that you'll need to produce the body of
your term paper.    In addition to being a fully functional word processor, it 
enables you to move directly from an outline to a term paper with a 
minimum of effort.

The Body Box appears in the lower portion of the screen, and looks like this.

To learn more about any of its features, simply click on it now.    Additional 
Help listings    include About Outlines and About Formatting (click on the 
highlights to read them, now).

User's Tip:    If the Body Box doesn't appear on the screen, its because you 
haven't created or opened an outline.    Click on About Outlines for more 
information.



Outline Box
The Outline Box contains all of the tools that you'll need to create and format
an outline.    In addition, it provides automatic indenting and numbering tools 
that make setting up and editing a breeze for even the longest and most 
complicated outlines.

The Outline Box is located just under the toolbar.    The Beginning of Outline 
and End of Outline markers signify the area within which your outline will be 
created.    To get started, simply click on the "+" (add a line) icon, and a pop-
up will prompt you to create the first line of text.    Don't worry about 
numbering this (or any other) line, since the proper letter or number label 
will be added automatically based on the line's position and indenting.    To 
adjust the indentation, finish typing in the line, then use the right and left 
arrow keys to move the line one position to the left or right; any necessary 
changes in the line's numbering will be made as soon as you click.

User's Tip:    Help listings that contain more information on creating outlines 
include About Outlines, Add Outline Section, Indent Outline Section, and 
Print Outline.    Click on any of the highlighted terms to find out more about it.



Reference Text
Use these boxes to record the information for your reference.

Simply click in the box that you want to add or change, then use your 
keyboard to type in or edit the information.    Repeat this process until all of 
your information or corrections have been recorded; it will automatically be 
saved as soon as you go on to the next listing, or click to use any of the pop-
up's other handy options.



Add New Reference
Click here when you're ready to record your first (or next) reference listing.    
Then use the text boxes to record your information (author's name, 
publication's name, etc.); it will automatically be saved as soon as you go on 
to the next listing, or click to use any of the pop-up's other handy options.

User's Tip:    To review your references once they've been typed in, simply 
click on the scroll bar (at the right edge of the pop-up) to scroll through your 
listings.



Sort References
Click here when you're ready to organize your reference listings, and they 
will immediately be sorted into proper bibliographic order by author's last 
name.

User's Tips:    If your references include more than one publication by the 
same author, his/her full name will only be printed once (subsequent listings 
will be preceded by dashes, for easier reading).    In addition, any publications
which were written with collaborators will appear after publications that 
he/she wrote alone.



Delete Reference
Click here to delete the current reference.    You'll note that the reference 
count adjusts immediately to confirm that the information has been 
removed.    (The count is located just under the text boxes, in a "1 of x" 
format.)



Quotes Around Articles
Click here to add or remove quotation marks from around the names of 
articles cited in your list of references.

User's Tip:    Including vs. not including quotes around article names is a 
matter of personal preference, although the most common style is to include 
them.



Reference Styles
Automatic reference styles make it easy to format for printing.    The style 
choices can be found by clicking on the toolbar's References command.    
When its pop-up appears, simply click again on your choice of styles.

Bibliography style uses the following order and punctuation:

Author.    Article/Chapter.    Publication.    Location.    Other.    Date.

For Reference style, the information is organized in the following manner:

Author.    Date.    Article/Chapter.    Publication.    Location:    Publisher.    Other.

The reference page's heading will also be adjusted to reflect your choice of 
formats.

User's Tip:    Unless your professor or teacher has made a special request, the
reference style is mostly a matter of taste.    However, the more concise 
Reference style is probably the most popular today, according to experts.



Outline Text Box
Type here to create or update the text for a new outline section.    When 
you're done, click on OK to add the text or on Cancel to ignore it.

User's Tip:    Don't worry about prefacing your outline text with the correct 
number or letter reference:    Pro One Term Paper will do this automatically, 
as soon as the section is added to the outline.



Help Contents
To choose from a list a major help topics, select this feature from the Help 
Menu.    Then, when the list of topics appears, simply click on the one that 
you'd like to learn more about.

Alternately, you can perform a Help Search to look for topics by keyword 
(click on the highlight now, for more information).



Help Search
Selecting this option from the Help Menu will put you into Search mode.    
Then simply follow the prompts to search for the tool or topic that you'd like 
to learn more about.

Alternately, click to see Help on Help for general information on using the 
Help system.



Paper Types
Use this feature of the toolbar's Ideas command to familiarize yourself with 
the basic different types of term papers.    Each type of term paper is named 
and described, and includes a sample topic/hypothesis that illustrates its 
structure/approach.

User's Tip:    This tool can be a helpful idea generator if you've already got a 
term paper topic, but are stuck on how to turn it into an interesting (and 
impressive) paper.



Footnote Facts
Use this feature of the toolbar's Ideas command to learn more about 
footnotes and referencing.

User's Tip:    Alternately, check out the two 'bibles' of writing, namely "The 
Chicago Manual of Style" and Kate Turabian's "A Manual for Writers of Term 
Papers, Theses and Dissertations".



List of Topics
Use this feature of the toolbar's Ideas command to review a selection of idea-
generating term paper topics.    Over 200 sample topics are included, in four 
different subject categories (American History; World History and Culture; 
Civics, Economics and Law; and Famous Americans).



Print References
Use this option of the Print Menu to print a copy of this term paper's 
References section.    The print request will be sent directly to the printer as 
soon as you click to select this option.

User's Tips:    The format for your reference list is automatically set according
to the style that you choose (Reference or Bibliography) and by your 
reference font selection.    Click to see the Help for References or Reference 
Styles for more information.



Margin Arrows
When the margins setting pop-up appears, click on the up arrow to increase 
the size of your margin, or on the down arrow to make it smaller.    Each click 
changes the margin by 1/10 of an inch.    Then click on OK to save your new 
settings or on Cancel to ignore them, when you're done.

Click to see the Help listing for the Set Margins command for more 
information.



        Character Colors
Click on this Body Box command to make the selected text appear in color.    
When you do, a pop-up will appear and prompt you with your choice of
font colors.    Then, simply click to apply your choice to the selected portion 
of text.

User's Tip:    Don't forget that your printer and monitor must be color-capable 
in order for you to print and preview your text in anything besides black and 
white mode.    However, the fact that you have a black and white monitor 
does not prevent you from printing in color, as long as you do have a color 
printer.



OK to Exit
Click on OK to exit from the Idea Bank and return to the main Pro One Term 
Paper Work Screen.



Page Numbers On/Off
Click here to turn page numbering 'on' and 'off'.    Then click on OK or Cancel 
to save or ignore this, and any other changes, that you are making.



Page Number Position
Click here to adjust your page numbers' position on the page.    Then click on 
OK or Cancel to save or ignore this, and any other changes, that you are 
making.



Page Number First Page
Click here to determine whether or not a page number appears on the first 
page. Then click on OK or Cancel to save or ignore this, and any other 
changes, that you are making.

User's Tip:    The first page will always be counted, even if no number is 
printed on it.    You'll probably want to choose this option if you've begun your
term paper with a title page.



Page Number Justify
Click here to adjust your page numbers' justification.    Then click on OK or 
Cancel to save or ignore this, and any other changes, that you are making.



Page Number Style
Click here to choose the style in which your page numbers will be printed.    
Then click on OK or Cancel to save or ignore this, and any other changes, 
that you are making.

User's Tip:    Unless your instructor has told you otherwise, the choice of 
pagination styles is merely a matter of personal preference.



Page Number Font
Click here to choose a font for your page numbers.    The subsequent pop-up 
will allow you to make your choice of fonts and sizes.    (Click to see the Help 
for Fonts, for more information.)

User's Tip:    Standard technique is to use the same font as is used for the 
body of the paper, at the same or a slightly smaller font size.    For example, 
if your paper is being printed at a font size of 12, you'll probably want to use 
either 10 or 12 for your page numbers.



About Formatting
Use the toolbar commands that appear at the top of the Body Box to specify 
the format for your term paper.    It provides a variety of formatting options 
which can be applied either to the entire term paper, or to a selected Term 
paper Section.

Begin by highlighting the part(s) of the term paper to which this format will 
be applied.    Then select the types of changes you want to make, and click 
on OK when you're done.    Options include:

Font Selection
Text Alignment, to set justification
Character formats including Bold, Italic and Underline
Character colors, to view and/or print color text
Spacing

In addition, you'll see a variety of useful editing commands that allow you to 
cut, copy and paste text, add page breaks, and insert pictures into your 
document.

Click on any of the highlighted Help topics to learn more about it, now.



About Outlines
A solid outline provides the foundation for a successful term paper.    And Pro 
One Term Paper makes it easier to create outlines by providing automatic 
formatting options.

To get started, simply go to the Outline Box and click on the "+" (add a line) 
icon.    A pop-up will prompt you to compose the first line of your outline.    
Repeat the process to fill in the rest of the outline, using the right arrow and 
left arrow keys to automatically set up your indenting and numbering.    Just 
that painlessly, your outline will be underway.

Pro One Term Paper automatically associates a particular outline with a 
specific term paper, and vice versa.    To further reduce confusion, they are 
saved as part of the same file, so that opening a term paper automatically 
opens its corresponding outline.

Click on any of the highlighted terms to learn more about it, now.



References Scroll
Use this scroll bar to review all of you references.    Either click on the scroll 
bar, or click and slide the button, to move up and down your references list.   
The information on the current reference will appear in the text boxes to the 
left of the scroll bar in the pop-up.



Reference Title
This is the title that will appear at the top of the page when your references 
are printed.    A default title -- either "References" or "Bibliography" -- is set 
when you choose one of these two reference styles.    But you can also 
change the title by clicking in this box and typing in a title of your own.



Font List
Use the scroll bar to move through your list of available fonts.    Then click to 
highlight the font that is your selection, and your choice will be confirmed by 
appearing in the box at the top of the list.    Your new font will be applied as 
soon as you click on OK to return from this pop-up.



Font Effects and Color
Click in the check boxes if you'd like your text to appear with strikeout or 
underline.    You can also select a color for your text by clicking on the font 
color box.    Any color and effects that you've chosen will be applied as soon 
as you click on OK to return from this pop-up.

User's Tip: Underline can be applied to your term paper even more 
conveniently by clicking on the underline button (see the Help for Character 
Formats for more information).



Font Style
Click to highlight your choice of font styles.    Your choice will be confirmed by
appearing in the box at the top of the list.    It will be applied to your term 
paper as soon as you click on OK to return from this pop-up.



Font Size
Use the scroll bar to move through your list of available font sizes.    Then 
click to highlight the font that is your selection, or click in the box to type in a
size of your own.    Your new font will be applied as soon as you click on OK to
return from this pop-up.

User's Tip: Just because a font size doesn't appear on the scrollbar list 
doesn;t mean that it can't be used.    So if 13 is the perfect font size for you, 
simply type it in.



File List
Use the scroll bar to move through your list of available files.    Then click to 
highlight the name of the file that you'd like to use, and your choice will be 
confirmed by appearing in the file name box at the top of the list.    The file 
will be opened as soon as you click on OK to return from this pop-up.

User's Tips: Don't forget that the choice of file name, drives, directories and 
file formats will dictate which files appear on this list.    So if you are looking 
for a file that you can't find, use these tools to widen your search.



Directories
Use this box to define the name of the directory in which your file(s) will be 
found.    Click to highlight the name of the directory in which you'd like to 
look, and the name will appear above the box in confirmation.    All of the files
that share the format for which you;re looking will then appear in the file list 
to the left of the pop-up.



File Format
Use this to specify the file format that you'd like to use.    To see more 
choices, click on the down arrow, and the full list of available formats will 
appear.    Then simply click to make your choice, and the file list will be 
updated to reflect your selection.



Drives
Use this to specify the disk drive on which your file(s) will be found.    To see 
more choices, click on the down arrow, and the full list of available drives 
(including floppy and CD-ROM drives) will appear.    Then simply click to make
your choice, and the directories list will be updated to reflect your selection.



Preview On/Off
Click here to turn the preview feature on or off.    When preview is on a 
miniature of your selected graphics file will appear on the pop-up, and give 
you a chance to confirm your selection before it is actually inserted into your 
term paper.    To preview another file, simply click on the file list to make 
another selection.



File Name
You may type in a file name here to select that file.    In addition, you may 
enter a name with wildcard characters (*, ?), and the file list below will 
display only those files in the current directory that match the file name that 
you entered.



References Font
Use this option to specify font characteristics for the references or 
bibliography section of your term paper.

When the pop-up appears, click to make your selections for the font, font 
size, font face (bold, italic or underline) and color.    Then click on OK to save 
your changes, or on Cancel to ignore them, when you're done.

          



Help on References

Click on any of the buttons or boxes, now, to learn more about references.



        Print Ideas
Click here to print a copy of the selected idea.



        Export Ideas
Click here to create a text file from the selected idea.






